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Abstract

Phalangeroid possums of New Guinea and Australia possess many traits convergent with Malagasy 

Strepsirrhines and provide researchers with an opportunity to shed light on the order of adaptive traits that 

lead to the appearance of the �rst primate. Like Strepsirrhines, phalangeroids are thought to have evolved in 

geographic isolation. �ey are well adapted to arboreal life through traits such as grasping hands and feet with 

reduced claws and an opposable �rst digit on the hind foot, increased orbital convergence for better depth 

perception and an overall large brain to body size ratio. While Strepsirrhines have been well studied from 

several scienti�c perspectives, data on phalangeroids is limited to morpho-ecological observations.

A strong case has been made for in-depth study of phalangeroids. A logical place to start is with 

the jaw adductors and dentition as such information provides scientists with an important foundational 

understanding of mammal phylogeny, adaptive history, diet and trophic structure. Characterization of any 

mammalian masticatory apparatus, however, requires a thorough understanding of spatial relationships as well 

as biomechanical traits derived from muscle mass, �ber length, physiological cross-sectional area and location 

of attachments sites. �is task is challenging enough for a single species and is increasingly di�cult when 

comparing two or more taxa. Unfortunately, the tools most commonly employed to document the three-

dimensional nature of chewing muscles are limited to two-dimensional outputs such as text, quantitative data 

displays, black and white line drawings and photography. To make matters worse, the e�cacy of such tools is 

compromised by poor quality of execution.

�is study aims to improve the ability of the scientist to draw meaningful comparisons between 

two taxa, Malagasy Strepsirrhines and phalangeroid possums, by introducing a re�ned set of visual 

communication tools including traditional �at illustration as well as a three dimensional reconstruction 

driven by volumetric data acquired from dissection of a single representative phalangeroid species, Trichosurus 

vulpecula. It is our hope that the contribution of these resources to the scienti�c community will help further 

the academic discussion regarding the evolutionary sequence of adaptations that de�ne the order Primate.
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Introduction

All modern mammals, with the exception of monotremes, diverged from a common therian ancestor 

during the late Jurassic approximately 160 million years ago (Luo et al, 2011) (�g 1). Today, of the 5420 

known mammal species, 335 are represented by metatherian (marsupial) radiations that primarily inhabit 

the forested regions of New Guinea and Australia, with a small number found in the New World ecosystems 

of South and Central America, plus a single species in North America (Vaughn, 2011; Mitchell, 2014). 

By contrast, the range of inhabited ecological niches and variety of adaptive traits possessed by eutherians 

(placentals) is far more diverse (Vaughn, 2011; Swindler, 2012). One such group, the Lemuriformes of 

Madagascar, of the suborder Strepsirrhini, are of considerable interest for their possession of primitive primate-

like adaptations. Both extant and extinct taxa provide researchers with insights as to the order of adaptations 

that led to the radiation of arboreal primates from a pre-primate insectivore, presumably a plesiadapiform, 

sometime near the Paleocene-Eocene boundary (Cartmill, 1974; Bloch, 2001; Lou, 2011; Swindler, 2012). 

�e fossil record for such antecendents, however, remains curiously absent (Swindler, 2012; Sussman, 1991). 

Evolutionary hypotheses about the order of acquired traits leading to Eocene prosimian varieties and, hence, 

modern primates are in a perpetual state of debate (Kay et al., 1990; Beard, 1993; Bloch and Silcox, 2001; 

Silcox, 2001).

One theory, the “visual predation hypothesis,” was proposed by Matt Cartmill in his 1972 article 

in Science titled Rethinking Primate Origins. Cartmill argued that of the 14 orders of terrestrial mammals, 

9 are arboreal and many of these, while highly successful as tree dwellers, are without possession of primate 

traits. He noted the locomotor habits of squirrels, the tree climbing ability of cats, and the prehensile 

forelimbs of chameleons among his examples. Prehensile hands and feet were quite common among shrub 

layer insectivores during the Eocene, while optic convergence was restricted to nocturnal predators of insects. 

Visual predation of insects in the lower canopy is a characteristic of extant prosimian forms (Tarsiers and 

Galagos) as well as some marsupials. Early primates, therefore, must have been nocturnal predators of insects 

in the lower canopy that relied on improved performance of the visual system to slowly stalk arthropods on 

terminal branches. Additionally, Cartmill argued that the plesiadapiform was a close collateral relative of early 

primates, rather than an antecedent form.

A more recent theory dubbed the “angiosperm exploitation hypothesis,” proposed by Robert W. 

Sussman in the American Journal of Primatology in 1991, has been steadily gaining support. �is is partly due 

to new data that demonstrates olfaction and auditory sensitivity to high frequencie, rather than stereoscopic 

vision, are a primary means of predation among omnivores. Galagos and Tarsiers are now know to use both 
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traits to stalk prey on the ground and not in trees or shrubs. Cats, likewise, rely almost exclusively on hearing 

to �nd predators scurrying beneath terrestrial detritus. �e most supportive evidence of Sussmans theory, 

however, is contained in the fossil record from the late Paleocene-mid Eocene that demonstrates a rapid and 

di�use coevolutionary event of �ora and fauna. Up to the late Cretaceous, the diaspore size of angiosperms 

remained relatively small, indicating of abiotic dispersal, and pollination is thought to have been performed 

primarily by insects. As the Tertiary approached, the size of diaspores as well as the range of angiosperm 

habits increased. �is coincided with new radiations of birds, plesiadapoids, marsupials and other groups in 

distinct regions, all of whom who bene�ted from the increased availability and diversity of plant products. 

�e size of angiosperm products remained relatively constant throughout most of the Paleocene, but as 

competition for plant products is thought to have increased, along with their consumption, new defensive 

adaptations among �ora as well as more e�cient means of exploiting these resources among biotic disbursers 

followed. �us, Sussman argues, the impetus for diversi�cation of mammals during the early Tertiary was 

a di�use coevolution of both �ora and fauna and the appearance of the earliest primate was not an isolated 

phenomenon.

Intuition suggests that increased phylogenetic distance between two or more taxa correlates with 

greater morphological variation in modern forms. When comparing the order Primate to all other mammals, 

this assumption appears correct. �ey are de�ned by a unique combination of several important adaptations 

including grasping hands and feet with opposable �rst digits and nails instead of claws, hind limb locomotor 

dominance, late onset sexual maturity, stereoscopic vision and reduced olfaction, large brain to body size 

ratios, and complex social behavior (Vaughn, 2011; Swindler, 2012; Rasmussen, 2007; Cartmill, 1972;). �e 

unfortunate aspect of primate phylogeny is that there are few opportunities for evolutionary scientists to test 

theories about the order and timing of these acquisitions. Evolutionary time far exceeds the lifespan of the 

researcher and there is no way to control for any particular variable during evolutionary runs to determine the 

e�ect of a single variable on an outcome.

It is fortuitous then that the phalangeroid possums of Australia and New Guinea, with a long history 

of independent radiation in similar ecological niches to that of Malagasy Strepsirrhines, possess so many 

morpho-ecological convergences (Smith, 1996; Freedland, 1975) (�g 1, 2). Like Strepsirrhines, phalangeroids 

are thought to have radiated in geographic isolation by bene�tting from a lack of competition for angiosperm 

products from other dispersers such as bird and bats (Lillegraven, 1974; Sussman, 1991). �ey are well adapted 

to an arboreal habitat and possess prosimian-like features such as grasping hands and feet with reduced 

claws and an opposable �rst digit on the hind foot, increased orbital convergence for better depth perception 

and a larger overall brain to body size ratio (Cartmill, 1972; Sussman, 1978; Rasmussen, 2007). �ey have 

similarly low reproductive rates and certain species, such as Cercartetus, exhibit social tendencies in their 
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nesting behavior (Rassmussen,2007). �e strongest evidence of primate-phalangeroid convergence obtained 

thus far has been observed in their dietary habits. Larger body-sized Lemuriformes and phalangeroids tend 

to be frugivore-folivores while in smaller genera frugivore-insectivory has been observed (Freedland, 1975; 

Goldingjay and Kavanagh, 1995; Smith, 1996; Dumont, 2000; Rassmussen, 2007). A particularly uncanny 

convergence occurs with respect to the post-cranial morphology and foraging strategies between the Malagasy 

aye-aye (Daubentonia) and non-gliding striped possum (Dactylopsila). Both are extractive foragers on larval 

insects and possess enlarged incisors used to gouge wood and open tunnels of wood-boring larvae . �e 

forefeet are used to tap the wood in an apparent use of auditory cues to detect hollows beneath the tree 

surface. Caches of larvae are then reamed out their bores by way of an elongated �nger with a hooked  

claw (Erickson, 1990).

�e current data on phalangeroids are limited to the types of morpho-ecological observations 

mentioned above and a strong case has been made for increased breadth of scienti�c studies (Sussman, 1978; 

Smith, 1996; Rasmussen, 2007). A logical place to begin is to study jaw adductors and dentition as such 

information can provide an important foundation to understand mammal phylogeny, adaptive history, diet 

and trophic structure (Vaughn, 2011). Many such studies have been undertaken with regards to Strepsirrhines 

(Hiiemae and Kay, 1973; Vinyard et al, 2003; Perry and Hardstone-Rose, 2010; Perry et al, 2011) and if 

analogous information is uncovered among phalangeroids, a deeper objective comparison between the two 

becomes possible.

Characterization of any mammalian masticatory apparatus, however, requires a thorough 

understanding of anatomical and spatial relationships as well as biomechanical traits derived from 

measurements of muscle mass, �ber length, physiological cross-sectional area and location of attachment 

sites (Taylor and Vinyard, 2004; Taylor et al, 2009; Perry et al, 2011; St. Clair et al, in prep; Harper, in 

Figure 1. �e phalangeroid possum Trichosurus vulpecula (left) and Strepsirrhine primate Otolemur crassicaudatus 
(right).  photo credit: Gerald Cubit, Arkive  Digital Media© 2011
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review). �is task is challenging and time consuming for both the scientist and student, whereas a detailed 

comparison between two or more unrelated taxa becomes increasingly di�cult. It is unfortunate then that 

the tools currently used to document the three dimensional nature of mammalian jaw adductors are often 

limited to two dimensional outputs such as text, quantitative data displays, black and white line drawings 

and photography. To make matters worse, the communicative e�cacy of these tools is compromised by 

not only the limits of 2D space, but also the quality of execution (Stark, 1933; Gaspard et al., 1973; Ross, 

1995). �e main goal of this study is to improve the ability of the audience to draw meaningful 

comparisons between two taxa, Strepsirrhines and phalangeroids, by introducing a re�ned set of visual 

communication tools including traditional �at illustration and, more importantly, a volumetrically 

accurate 3D physical and virtual reconstruction of the phalangeroid masticatory apparatus. �e 

secondary goal of this study is to document the reconstruction work�ow so that additional 3D 

representations of subsequent mammalian masticatory apparatus can be created by third parties and 

thus continue to build upon the collective knowledge comparing Strepsirrhines and phalangeroids. It 

is the hope that the contribution of these resources to the scienti�c community will help further the academic 

discussion regarding the evolutionary sequence of adaptations that de�ne the order Primate.
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Figure 1. Combined geologic timescale and Phylogentic tree of mammal forms.
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Materials and Methods

I: Species Selection

�e family Phalangeridae is contained within the order Diprotodontia, and includes 6 genera and 

72 extant species of both possums and cuscuses (Smith, 1996; Vaughn, 2011). While several other possum 

families have been noted for their similarities to Strepsirrhines, our study was limited by the regional 

availability of specimens. �e Smithsonian Institution National Museum of Natural History in Washington, 

DC, was sought out for its collection of �uid preserved phalangeroid specimens which included the 

following genera: Phalanger, Trichosurus, Potorus, Petauroides and Pseudocheirus. Of these only Trichosurus 

and Pseudocheirus were suitable in both quantity, maturation level and state of preservation to qualify for 

dissection. Trichosurus vulpecula was chosen as a primary candidate for study because of the aforementioned 

factors, but also because it is the most well documented genus with respect to morpho-ecological observations 

and is at low risk in terms of species conservation (�g 3). 

II: User Interviews and Establishment of Design Criteria

To more fully understand needs of the audience, qualitative user interviews were conducted with 

three professors and two graduate students at the Center for Functional Anatomy and Evolution at the Johns 

Hopkins University School of Medicine. �e interview protocol and detailed summary of responses can be 

found in the appendix at the back of this document. Users were interviewed individually in a private setting 

and audio for each interview recorded and later transcribed. �e interview was divided into two parts. Part 

Figure 3. From left to right, adult Trichosurus vupecula specimens #236802 (male) and 
#236806 (female). Both harvested from Australia between 1920-1923.
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one asked participants to describe their scienti�c background, the importance of chewing muscles to their 

current work, and aspects of the chewing muscle anatomy that were the most challenging to comprehend. Part 

two asked participants to describe the range and depth of their familiarity with currently available visual tools 

used to communicate information about chewing musculature. �is section also asked users to describe what 

an ideal visual tool on the subject of chewing muscles would look like. �e design criteria born out of these 

interviews is presented in the results section of this document. 

III: Data Acquisition and Processing of Hard Tissue

Step 1: Horos Segmentation

�ree dimensional data of Trichosurus cranial anatomy was acquired by computed tomography at 

a slice resolution of  0.1063 mm using a GE Phoenix V Tome XS Industrial High Resolution CT/X Ray 

Scanner housed at the University of New England, New South Wales, Australia. A total of 856 images 

were processed in Horos, a free DICOM medical image viewing software. Upon initially generating a three 

dimensional volume from the scan data, it was observed that the interior of the nasal passages, sinus cavities, 

brain case and diploe of the zygomatic arches and mandible possessed signi�cant amounts of sparse data, or 

noise, that would be problematic at the time of physical prototyping. To solve this, noise was removed using 

the Region of Interest functionality within Horos. �e steps involved in this process are outlined below.

1. Scroll to an image within data set where an ROI generation is desired
• goto ROI>Set Default ROI Name, and enter desire name for new 

ROI
2. Draw an ROI

• Select the Pencil tool (�g 4), draw around region of interest 
• Keep ROI’s to simple shapes (�g 5). Complex shapes will generate 

undesired results.
• Do not draw more than one shape on any image for a single ROI.

3. Drawing the second ROI
• Scroll through data set to next desired image (approximately 10-20 

images) where the anatomical region undergoes a modest change of 
shape (�g 6)

• �is ROI will be stored under the name originally speci�ed 

Repeat steps 1-3 as necessary as desired for an anatomical region

4. Generating missing ROI’S, or “in-betweens” 
• Main Menu: ROI>ROI Volume>Generate Missing ROI’s

5. Check shapes of the generated ROI’S 
• Scroll through images and look for undesired results
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• use Repulsor tool to nudge ROIs or…
• delete the ROI and redraw with the Pencil tool.

6. Change the pixel value within the ROI
• goto ROI>Set Pixel Values to… and input the following settings

• Apply to: “ROI’s with the same name as selected ROI”
• Set pixels that are: “Inside ROI’s”
• If current value is larger that: “0”
• If current value is smaller than: “1000”
• To this new value: “1000

�e region within the ROI’s will be set to white.

Steps 1-6 were repeated to generate additional sets of ROIs for each anatomical region. �e next step 

involved generating a 3D volume rendering (Main Menu: 3D Viewer> 3D Volume Rendering). Houns�eld 

units were adjusted to remove additional noise and soft tissue artifacts (select 16-BIT button, then the 

“gradient” icon, adjust histogram display of houns�eld units will at the bottom of the screen) (�g 7). Width 

and height of the histogram was adjusted until the rendering preview appeared suitable for surface generation 

(Main Menu 3D Viewer>3D Surface Rendering). A drop down menu appeared and the values for smooth 

iterations and pixel value were set to 100/186, respectively (�g 8). �is improved the surface quality of 

the model upon export. Lastly, a Wavefront OBJ �le was exported for use in 3D modeling software. �is 

functionality can be found by opening the drop down menu next to the “gear” icon at the top right of the  

tool bar (�g 9).

Figure 4. Horos toolbar (A). Zoomed in view of “Mouse button function” tools (B). Location of Pencil tool (C). 
Not all text intended to be read.

A.

B. C.
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Figure 5. Drawing of the �rst ROI. Note relatively simple shape and 
location of image within dataset. Not all text intended to be read.

Figure 6. Drawing of second ROI with shape close to that of �rst. Position 
within data set is approximately 20 images further to the right. Not all text 

intended to be read.
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Figure 7. Horos window showing position and spread of houns�eld unit histogram and 3D volume rendering. 
Location of gradient tool icon (A). Location of “16-bit” button (B). Not all text intended to be read.

Figure 8. 3D Surface rendering drop down 
window.

Figure 9. Location of drop down menu for export of 3D 
surface rendering. Not all text intended to be read.

A. B.
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Step 2: Reorientation and Auto-Grouping in ZBrush

�e OBJ �le of the segmented anatomy was imported into ZBrush, a polygonal-based 3D modeling 

software. Upon import, the cranium and mandible were positioned in an oblique orientation. Using the Move 

Transpose tool, they were rotated independently until an orthogonal orientation was attained. �e imported 

data included super�uous topology that was non-continuous with the bony anatomy, such as the scanning 

bed and noise within the scan �eld. �is information was quickly removed by using the automatic polygroup 

function (Tools>Polygroups>Autogroups) that regrouped the mesh based on surface continuity. Next, the 

cranium and mandible were isolated (Command + Shift>click on the bony anatomy) and the hidden mesh 

data deleted (Tools>Geometry>Modify Topology>Delete Hidden). With the non-continuous geometry 

removed, the cranium and mandible were retopologized using the dynamesh function at a resolution of 600. 

�is greatly reduced the polycount and allowed for a more lightweight model, without losing detail. �e 

model was now ready for re�nement.

Step 3: Artifact Removal

�e next step in processing the model involved continuous artifact removal, smoothing, 

symmetrization of the cranium and mandible, and re�nement of detail around the dentition and suture 

lines. �e scanned specimen was not free of soft tissue and there was signi�cant obfuscation of the dentition 

and muscular attachment sites. Several strategies were employed to correct this. �e Lasso brush (Control 

Figure 10. Areas of soft tissue projecting o� bone (A). Projecting soft tissue removed and hidden mesh deleted 
(B). Result after closing holes (C). Re�ned surface after smoothing (D).

A.

C.

B.

D.
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+ Shift) was used to select and hide mesh data that projected o� surfaces of the model. �e hidden mesh 

was then deleted (Tools>Geometry>Modify Topology>Delete Hidden) and the resulting holes closed 

(Tools>Geometry>Modify Topology>Close Holes). �e closed surface was then blended into the 

surrounding topology with the smooth brush. �ese steps were repeated on the remaining surfaces  

where necessary (�g 10). 

Step 4: Symmetrization

Before detailed sculpting could take place, the model was made symmetric across a midsagittal plane. 

�ere are several advantages to doing so. First, with symmetry active (Tools>Activate Symmetry> select axis 

X,Y, or Z), details that appear bilaterally can be sculpted simultaneously, greatly speeding up the work�ow. 

Second, inconsistencies across the midline such as missing anatomical landmarks may cause confusion among 

the audience, lower the perception of quality, and reduce overall con�dence in accuracy. Lastly, it was desired 

to have the option of a bilateral reconstructon of the musculature. A symmetric model would allow mirroring 

of subtools after creation on a single side, a signi�cant time savings.

Holding shift while using the Slice Curve brush, both the mandible and cranium were 

bisected close to the midline. �e least desirable side of the model was then hidden and deleted. �e 

remaining side was duplicated (Tools>Subtools>Duplicate) and mirrored (Tools>Deformation>Mirror, 

select axis). With each half adjacent to each other in the subtool palette, the two halves were merged 

(Tools>Subtools>Merge>Merge Down) and dynameshed at 600 resolution into a single continuous mesh. 

Because both cranium and mandible were not split exactly on center, a slight seam, or �ashing, appeared after 

uni�cation. �is was easily removed using a combination of the Standard, Damien Standard, and Smooth 

brush where necessary. 

Step 5: Detail Re�nement

Using photographic reference as well as a physical Trichosurus vulpecula cranial specimen acquired 

from the Smithsonian National Museum of Natural History, details around the dentition and suture lines 

were resolved. To improve the e�ciency of this process, reference images were loaded onto the canvas using 

the Spotlight feature within ZBrush. By default, ZBrush recognizes spotlight images as projection maps for 

purpose of image based texturing of a mesh. Once loaded, sculpting beyond the border of the image will be 

restricted, so Spotlight Projection must be disabled (Brush>Samples>deselect Spotlight Projection). Images 

were loaded by activating Spotlight (Shift + Z) and importing them as textures (Texture>Import>select 

�le). �ey were then copied to the canvas (select image > Add to Spotlight) upon which a radial marking 

menu appeared. �e opacity, size and arrangement of the images were adjusted and once satisfactory the 
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Spotlight menu was turned o� (“Z”). Like Spotlight Projection, the menu restricts sculpting within the image 

boundary. An example of Spotlight images on the canvas can been seen in Figure 11.

With the symmetry function active, a combination of brushes were used to resolve various details. 

�e Damien Standard brush employs a fallo� parameter to allow sculpting of �ne lines cut into or pulled 

out from the surface. �is was especially useful around the base of the dentition, the dental occlusal surfaces, 

and suture lines on the cranium. �e Smooth Brush was used sparingly on the labial or buccal surfaces. 

Because of the detailed nature of dentition, any gross addition or subtraction of dental surfaces was carefully 

avoided. While this project is not a study in phalangeroid dentition, the objective with respect accuracy was to 

prevent the invitation of doubt by the audience. Resolving the dentition was important to achieving this goal. 

Eventually, remaining surfaces were carefully blended to remove the overall stair-stepped appearance, a natural 

artifact of CT data segmentation (�g 12).

Figure 11. Screen capture of Spotlight images loaded onto canvas 
within ZBrush.

Figure 12. Unedited import of Horos data (left). Horos data after re�nement within 
ZBrush (right).
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IV: Dissection of the Masticatory Apparatus

�e left side masticatory apparatus of four Trichosurus vulpecula specimens was dissected, however, 

two specimens were discovered to be juvenile and not used in the �nal data set. Only the details important to 

phalangeroid masticatory dissection are noted here. First, an approximately seven centimeter midline incision 

on the dorsum of the cranium was made with a #15 curved scalpel, followed by a circumferential incision in 

the coronal plane approximately 1 cm distal to the tip of the snout. �e skin was re�ected inferiorly up to the 

external auditory meatus and conjunctiva of the eye, at which time a circumferential subcutaneous incision 

was made around each. Finally, a 5-6 cm midline incision on the ventral surface of the mandible was made 

and the skin re�ected caudally exposing the entire masticatory apparatus. 

 �e Masseter group is the most super�cial of the jaw adductors and contains four layers. From 

super�cial to deep these are the super�cial masseter, external part of the external adductor (EPEA), internal 

part of the external adductor (IPEA), and zygomatico-mandibularis. �e posterior aspect of the super�cial 

masseter is covered by the parotid gland, which was carefully excised. A shallow horizontal incision was made 

following the parotid duct, which parallels the superior border of the super�cial masseter. �e muscle was 

then dissected away from underlying layer (EPEA) by releasing it from the inferior tubercle of the zygoma and 

re�ecting it caudally. 

�e EPEA and IPEA are tightly invested with each other and great care must be taken to remove 

them without causing mutilation. �e technique used here began by releasing EPEA from its insertion 

along the inferior edge of the mandibular angle then re�ecting it dorsally. Next, the IPEA was released 

Figure 13. Incision pattern for dissection of left jaw adductors. Solid lines indicate subcutaneous incisions.
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from its origin on the inferior edge of the zygomatic arch and re�ected ventrally. �is exposes zygomatico-

mandibularis which could then be dissected from its origin and insertion on the inferior medial edge of the 

zygoma and the masseteric fossa, respectively.

�e Temporalis group consists of the super�cial temporalis, deep temporalis and zygomatic 

temporalis. �e dissection of this group is made challenging by the narrow space between the zygomatic 

arch, coronoid process and cranium.  Super�cial temporalis was removed by making an incision around the 

perimeter of its origin and then locating the fascial plane dividing it from zygomatic temporalis near the 

inferior posterior orbital process of the zygoma. Zygomatic temporalis could then be approached superior 

and inferior to the zygoma. Once su�ciently mobilized, zygomatic temporalis was pushed inferiorly through 

this space. Next, deep temporalis was dissected o� the cranium and released from its insertion on the medial 

surface of the coronoid process. 

�e pterygoids are the last muscles to be removed and are completely obscured by the mandible. 

To gain access to the pterygoid insertions, the mandible was divided at the symphysis and retracted laterally. 

Once the mandible is completely removed, the maxillary artery and third branch of the trigeminal nerve 

become visible; these serve as a landmark dividing the medial and lateral heads. Both muscles were then 

released from their origin deep within the suborbital space. 

Photographs of each muscle were taken 

both in situ and after removal making sure to 

orient each specimen with respect to its anterior 

and dorsal position. Each muscle was individually 

wrapped in a paper towel wetted with preserving 

�uid, placed in a sealed plastic bag and later 

weighed using a Gemini-20 portable milligram 

scale, produced by American Weigh Scales 

Inc. Origins and insertions were noted during 

dissection by drawing on a worksheet containing 

orthographic views of a Trichosurus vulpecula 

cranium and mandible (�g 14).

V: Digital Muscle Reconstruction in Z-Brush

Using photography and notes obtained from dissection, the muscles were reconstructed digitally in 

ZBrush. �is document assumes the audience has an intermediate level of pro�ciency with the software and 

only techniques essential to the project will be discussed. Depending on the three-dimensional complexity of 

Figure 14. Dissection workstation at the Smithsonian Museum 
Support Center in Washington, DC.
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each muscle layer, di�erent modeling strategies were used. 

Technique #1: Sculpting muscles by extraction

For muscles with complex three dimensional shapes and broad areas of attachment, such as deep 

temporalis, super�cial temporalis, and super�cial masseter, reconstruction began by �rst masking then 

extracting a new mesh from the surface of the bony anatomy. Working deep to super�cial, a mask was applied 

to a site of either origin or insertion (hold command then click to paint mask on surface). A new mesh was 

extracted (Tools>Subtools>Extract>Apply; S Smt = 5, �ick = .02 ) and immediately dynameshed to create 

even topology. Next, the super�cial surface of each mesh was deformed toward one another using the Move 

brush. Once the meshes overlapped, they were merged and dynameshed. Using the Move and Clay Build-Up 

brushes, the form was re�ned until it matched the that of the muscle observed during dissection (�g 15-17).

Technique #2: Sculpting muscles using primitives

 For muscles with relatively planar forms such as the EPEA, IPEA and zygomatico-mandibularis, 

reconstruction began by appending a new polymesh 3D sphere object into the model. With symmetry active 

(Transform>Activate Symmetry>select axis), the Move brush was used to �atten the sphere into a disc-like 

shape which was then transposed to the appropriate location. �e form was re�ned using the Move and Clay 

Build-Up brushes.

Technique #3: Subtracting overlaps using Boolean operations

 After sculpting the general shape of each muscle layer, several Boolean operations were performed to 

eliminate overlaps between layers of adjacent meshes. �is step was crucial to facilitate ease of assembly and 

disassembly of muscle layers in the physical model. A dedicated tool for doing so was created by duplicating 

the cranium and mandible subtools (Tools>Subtools>Duplicate) then trimming o� non-essential portions of 

the geometry using the Trim Curve brush. A + 0.002 o�set of each mesh was then created using the extract 

function (Tools>Subtools>Extract>Apply) which would allow a slight tolerance of negative space between 

various parts (�g 18). Both new extractions were renamed, then the mesh used to create them was deleted. 

Anytime a Boolean subtraction of bone from muscle was needed, either of these meshes could be duplicated 

and used to do so without the risk of accidently deleting the original subtools of the bony anatomy. 
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A.

C.

E.

B.

D.

F.

Figure 15. Masked area of zygomatico-mandibularis insertion (A). New subtools (arrows) created after 
using extraction function (B).  Overlapping meshes after deformation (C). Resulting mesh after merging 
and retopologizing with dynamesh (D). Re�ned general shape of muscle (E). Muscle as viewed through 

bony anatomy (F).

Figure 16. Subtool menu indicating new 
subtools created from extraction (arrows).

Figure 17. Extract menu with settings used. (S Smt = 5, 
�ick = 0.02).
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VI: Mass evaluation in SolidWorks

 SolidWorks is a parametric 3D solid-modeling software used in engineering and product 

development industries. ZBrush is marketed toward artists and does not contain tools for evaluating physical 

properties of models such as mass and volume. �e process of measuring the mass of the reconstructed 

musculature was highly iterative as each mesh had to be repeatedly measured, re�ned, re-exported and re-

veri�ed. Once accurate volumes were acheived, textural details indicating �ber direction were added after 

which one �nal mass veri�cation was performed.

 �e �rst step in mass evaluation is to export a separate STL for each ZBrush subtool. SolidWorks 

however, is not designed to handle quadrangular meshes, those with large numbers of polygons or any surface 

with unclosed contours. Using the decimation master function within ZBrush (ZPlugin>Decimation 

Master), each subtool was converted to a triangular mesh with a signi�cantly lower poly count. Depending 

on the number of active points, a setting from 10-20% was used to achieve approximately 5,000 total active 

points per subtool. An active point count higher than 10,000 was found to be ine�cient to work with. �e 

steps involved in decimation are as follows:

1. Save the ZBrush project with a new name.

2. Set decimation percentage (this is the percentage of total points that will remain).

• Select Preprocess Current.

• Select Decimate Current.

Figure 18. Left cranium (transparent) and o�set subtool (opaque) with zygoma removed (A). Left mandible 
(transparent) and o�set subtool (opaque) (B). O�set left zygoma (C). Close up of previous view (D).
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Once decimation was complete, each subtool was exported as an STL (ZPlugin>3D Print 

Exporter). �e steps involved in exporting STL �les from ZBrush are:

3. Change units (in this case, millimeters (mm) were used).

• Select Update Size Ratios.

• Select Visible, and make sure only the subtool targeted for export is visible.

• Under Advanced options>>>, turn o� Textures and Colors.

4. Near the top of the menu, select STL. ZBrush will export the �le and ask for  

save information.

 Next, the STL �les were imported into SolidWorks. Opening STL �les in SolidWorks is relatively 

straight forward. In the Open dialog box, the �le type is changed to STL. Above this drop down menu is 

a button titled Options. Here the import type was set to Solid, and the �le was opened in the modeling 

window. To measure the mass, the Mass Properties icon was selected from the Evaluate tab on the horizontal 

tool bar at the top of the screen. A dialog box opens where Options was selected allowing one to input custom 

settings. �e Length, Mass, and Per unit volume were set to millimeters, grams and milliliters, respectively. 

Under Material Properties, the density was set to 1.06 g/ml (Murphy, 1974) and the Accuracy level left 

at Lower (�g 19). �e process of attaining an accurate mass for each muscle required several iterations of 

sculpting, exporting, and re-verifying, a total working time between four to six hours. 

An important consideration when evaluating muscle mass in SolidWorks is the unavoidable 

discrepancy that occurs wherever material thickness in the specimen is too thin to translate into the physical 

model. Areas composed almost entirely of connective tissue, for example, the midline cranial attachment of 

Figure 19. SolidWorks part window (right) with enlarged view of Mass/Section Property Options 
menu (left). Not all text intended to be read.
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super�cial temporalis, were locally overbuilt to add structural stability. While such areas have an insigni�cant 

contribution to the overall mass in the dissected specimen, the additional material drastically altered the 

values in the reconstruction. �e solution to this involved use of extruded cut features in SolidWorks to trim 

them away and record a mass value before and after the operation (�g 20). 

Adding muscle texture

After mass veri�cation, textural details indicating �ber direction and locations of connective tissue 

such as tendons and fascial sheaths were added (�g 21). Starting with the Clay Buildup brush, a default 

square alpha and Z-Intensity setting from 10-15, directional lines were alternately added and subtracted on 

the surface and then smoothed to create a �rst and second level hierarchy of texture. �e next level of detail 

involved use of the the Damien Standard brush with a default Z-Intensity of 25 to sculpt �ne lines between 

select areas of muscle �bers. Finally, the Rake brush was used with a default alpha and a Z-Intensity between 

8 and 10 to sculpt the appearance of very �ne lines to indicate areas of tendon and fascia. Adding textural 

detail to the muscle was important in communicating �ber direction, however, the process did change the 

volume of the subtool slightly and re-veri�cation of each mesh was required after completion.

VI: 3D Printing

�e process of readying the ZBrush �le for three dimensional printing involves several steps to 

account for inherent cost and manufacturing constraints. �e main driver of cost is the volume of structural 

and support material comsumed. Several steps were taken to mitigate this. First, use of structural material 

was reduced by retaining the negative space of the brain cavity and hollowing out the nasal passage (due to 

signi�cant noise, this area was �lled solid during the segmentation process in Horos).  Second, both cranium 

and mandible were split at the midline and printed in halve. �is created a broad, �at surface to lay on the 

printer bed and greatly reduced the use of support material. Finally, where possible, subtools were rearranged 

Figure 20. Super�cial temporalis before (left) and after (right) subtracting areas of connective tissue.
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Figure 21. Primary layer of texture added with the Clay Build-Up brush (A), then smoothed (B). Secondary 
layer of texture using a slightly smaller brush size (C), then smoothed (D). Creating creases in select areas with 

the Damien Standard brush (E). Finest level of detail, Rake brush used to convey connective tissue  
near origin (F). 
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in a con�guration such that their structure took the place of support material. For example, the pterygoids 

were repositioned within either the left or right brain case (�g 22).

Step 1: File Preparation 

Splitting the cranium and mandible was performed by duplicating each subtool, and then subtracting 

away the non-desired half using a polymesh 3D cube (�g 23). Because of the complex internal geometry of the 

cranium, simpler methods such as using the “slice curve” brush followed by a “close holes” operation produced 

undesirable results. �e steps involved in splitting these two subtools are outlined below.

1. Append a new polymesh 3D cube into the model (Tools>Subtools>Append).

2. Use the Move Transpose tool to re size the cube approximating the proportions of the 

targeted subtool

• turn on polyframe mode with lines

• with Move Transpose selected, click on any point on a face of the cube

• rotate the view to be parallel to the direction of the transpose line

• hold Shift and click on the center 3rd ring of the transpose line to unidirectionally 

scale the cube while holding the position of that face

• repeat this in other directions until desired shape is reached

3. Move the cube subtool so that is just overlaps the midline of the bony anatomy, then 

duplicate and mirror the new subtool to the opposite side (Tools>Deformation>select 

appropriate axis>Mirror)

• Increase the scale of the duplicated cube making sure not to change the position of 

the face on the midline

• Use Dynamic Subdivision to generate additional topology (Tools>Dynamic 

Subdiv>Q Grid = 0; Flat Sub = 2; Smooth = 0>Apply), delete lower subdivisions 

(Geometry>Del Lower) then Z-Remesh both cubes.

• Duplicate the larger subtool and use it to Boolean subtract material away from the 

�rst cube.

�e midline face of each cube will be perfectly coincident with one another.  

Figure 22. Arrangement of select subtools for printing �rst prototype. Right cranium and mandible have been 
split (see Step 1, below) and were �xed together with posts. Super�cial temporalis and zygomatico-mandibularis 

o�set from surface with medial pterygoid repositioned inside braincase of right cranium (arrow).
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4. Duplicate each cube subtool such that there is a “set” for both cranium and mandible.

• note: it is helpful to rename each cube according to which side they will be removing 

material from, ie: right cube is renamed “RT CUBE CUT.” 

5. Duplicate the cranium and mandible subtools.

• note: it is helpful to rename the cranium and mandible subtools according to 

which side will remaing after subtraction, i.e.: one cranium subtool renamed “LT 

CRANIUM”, other renamed “RT CRANIUM” 

6. Use cube subtools to Boolean subtract a side of corresponding cranium/mandible subtool. 

• i.e: RT CUBE CUT subtool subtracts from LT CRANIUM subtool..

Cranium and mandible should be split into halves, each having a face coincident with the sagittal plane.

After splitting the cranium and mandible, each subtool was decimated then exported as an STL 

using the same work�ow described in the previous section. �e decimated �le was saved separately to preserve 

the higher resolution, quad-based mesh in the likely possibility that it would undergo further re�nement. 

Within the decimated �le, individual subtools were rearranged to minimize use of support material. 

Figure 23. Initial placement of appended Polymesh 3D cube (A). Resized cube positioned to slightly overlap 
midline (B). Position and size of duplicated and mirrored cubes (C). Resulting right cube, ZRemeshed, after 

subtracting overlap with left (D).
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Step 2: Processing STL �les in MeshMixer

Prior to printing, �les must be checked for unclosed contours and resolved if any should occur. 

Autodesk Meshmixer is a free downloadable software that can be used to pre-process triangular meshes 

for 3D printing. Each STL �le or assembly was imported into Meshmixer and inspected for errors 

(Analysis>Inspector) (�g 24). �e process of using Dynamesh within ZBrush should eliminate most issues, 

however, portions of the cranium and mandible contained overlapping polys that were resolved using the Auto 

Repair function. �e repaired mesh is then exported as an STL (File>Export) and saved  

over the original �le.

Step 3: Importing into Stratasys Objet Studio 

Translation of the digital model into physical form was executed using a Stratasys Object 260 

Connex 3 multi-material 3D printer, housed at the Johns Hopkins Carnegie Center for Surgical Innovation. 

�e printer builds parts by depositing successive layers of UV cured resin on a metallic plate. It has a X, Y, Z 

resolution 600, 600, 1600 dpi respectively and an accuracy of 20-85 microns for features less than 5 cm in 

height (http://www.stratasys.com/3d-printers/design-series/objet260-connex3). �e Objet Studio software 

is very intuitive. STL �les were inserted, automatically placed (Placement), validated for unclosed contours 

(Validate) after which an estimate was generated (Estimate) (�g 25). 

VII: Creation of Assembly Features

Because the physical model would require somewhat skillfull handling of the many individual 

components, the e�ectiveness of it as a teaching tool would be reduced if it was burdened by a high intrinsic 

Figure 24. Enlarged view of Analysis tools within Meshmixer (left). Inspector tool (arrow) is 
used to analyze mesh for unclosed contours (indicated by red ball and stick, right). Not all text 

intended to be read.
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cognitive load Sweller, 1994). �erefore, the assembly features needed to be well thought out. Assembly 

features were created entirely in ZBrush using various hard surface modeling strategies. SolidWorks 

engineering software was investigated as a potential tool as well, however, it is not designed to handle large 

amounts of mesh data and the work�ow was found to be ine�cient. An additional bene�t of using ZBrush 

is that it allows more freedom for the designer to create shapes for assembly features that appear aesthetically 

native to the model. For example, a press �tting could be made to follow the edge of area of insertion for a 

muscle, thus tying its shape to the information needing to be conveyed. �ree strategies for assembly features 

were investigated and are outline below. A total of two prototypes were created to allow iterative re�nement 

before building the �nal model. Photographs of the protoypes can be viewed in the Results section of this 

document.

Strategy 1: self-retaining parts

If two parts had interlocking geometry that prevented 

passive disengagement from one another, the part 

was determined to be self-retaining and no additional 

mechanical features were created. �is was the case for 

Deep temporalis, as seen in Figure 26. 

Figure 25. Objet studio window with preview of STL �les on printer bed (text not intended to be read).

Figure 26. Deep temporalis is held in place through 
naturally occurring interlocking geometry.
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   Strategy 2: Press �ttings

If a two parts were not able to be self-retained, 

additional geometry was added in the form of positive 

and negative shapes to create interlocking geometry. 

Most often this took the form of a boss or rib that 

mated with a pocket on the opposite part (�g 27).

Strategy 3: Magnetic fastening

When the addition of a press �tting did not fully secure 

one part to another, small neodymium iron-boron rare 

earth magnets (https://www.mcmaster.com/#standard-

magnets/=16u4yq6) were embedded into the surface 

and secured with cyanoacrylate adhesive (�g 28).

A: Creating Press Fittings

�e �rst step in creating the positive feature of the press �tting was to duplicate the subtool it will be 

added to (Tools>Subtools> Duplicate). Next, the camera view was oriented normal to the surface targeted 

for feature creation. Most often this was an orthographic view. �e Slice Curve brush with Lasso stroke 

(Control+Shift>select brush from palette) was used to make a new polygroup from the surface (�g 29-A). 

�e new polygroup was isolated (Control+Shift>click on portions of mesh to hide) and the hidden portion 

of the mesh deleted (Tools>Geometry>Modify Topology>Delete Hidden) along with any parts of the new 

polygroup deep to the outer surface (�g 29-B). �e Slice Curve brush will often leave facets of polys along 

the cut edge of the new polygroup. �e Lasso Tool was used to hide the facets which were then deleted. Next, 

the polygroup was retopologized using ZRemesher (Tools>Geometry>ZRemesher) with the Same setting 

selected, keeping the exact number of poly’s as the previous mesh while creating uniform  

topology (�g 29- C, D).

�e retopologized surface was then �attened using the Planar Brush (�g 29-E, F). By clicking on 

a relatively �at region in the mesh and moving over the surface, polys above the group normal will be aligned 

Figure 27. Post extruded from pterygoid fossa (arrow) to 
allow retention of the medial pterygoid.

Figure 28. Press �tting with pocket for magnet to 
attach pterygoids to on another.
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Figure 29. Shape of new polygroup made from duplicated mandible subtool (A). Resulting mesh after hiding 
and deleting remainder of duplicated mandible (B). Topolgy before (C) and after (D) removal of facets and 

ZRemesh operation. Before (E) and after (F) �attening using the Planar brush. Extruded shape using ZModeler 
brush with Qmesh action and Flat Island target (G). Position of extrusion on original mandible subtool (H).
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to the same plane of the poly originally clicked. Holding alt modi�es the brush function so that polys below 

the normal will be aligned. Using the Planar brush takes some practice and based on a polys distance from the 

region clicked, several passes may be needed to create �at topology. Once �attened the surface can be used to 

create a linear extrusion with a smooth edges and no undercuts or tapers that would adversely a�ect  

user interaction.

Extrusion of the �attened shape was accomplished with the ZModeler brush. Hovering over a poly 

and pressing spacebar will open the ZModeler menu. Qmesh was selected from the poly actions menu, 

the target area set to Flat Island and the modi�ers left at their default settings. Releasing spacebar exits 

the ZModeler menu. An extrusion can then be created by hovering over a poly and clicking and dragging 

a desired distance (�g 29-G) making sure not to exceed the outer wall of the counterpart mesh that will 

mate with teh extrusion. A second extrusion was then created in the opposite direction to provide enough 

overlapping geometry to allow it to be merged with its parent (�g 29-H). Prior to merging, the entire 

extrusion was retopologized using the ZRemesher (settings: Same, Adaptive) and a + 0.002 extraction was 

created (Tools>Subtools>Extract) to later Boolean subtract a cavity from the subtool that the extrustion 

is meant to mate with. Finally, the positive extrusion was merged with its corresponding subtool and then 

dynameshed to create a single continuous part.

B: Creating Pocket Features for Magnets 

Boolean operations were used to create pockets allowing cylindrical rare-earth magnets to be 

embedded into the model (�g 30). �e pockets needed to be dimensionally accurate, however, the ability of 

ZBrush to build parametrically accurate shapes is limited and highly unintuitive. A range of magnet sizes 

were investigated. �e height and diameter of magnets were measured with a pair of digital calipers so they 

could be modeled in Cinema 4D to exact speci�cations. Next, a clearance model was made to use for Boolean 

subtractions where magnets were to be embedded. Each clearance model accounted for an additional 0.25 mm 

in diameter and 1.0 mm in height. A single circular face of the clearance model was extruded further which 

left an edge to use for alignment during the subtraction process. �e clearance model was exported as an STL 

then imported into the ZBrush model of the reconstruction.
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VIII: Surface Patterns for sites of Origin and Insertion

�e right half of the model was intended to show patterns of origin and insertion for each muscle of 

the masticatory apparatus. To accomplish this, a pattern was created in Illustrator and exported as a PSD to 

use as an Alpha within ZBrush. �e pattern was designed as an o�set array of tightly spaced circles that would 

be embossed on the surface to indicate an origin and debossed to indicate an insertion (�g 31).

For increased control over the appearance of the O/I patterns after they are made, individual 

layers were created for each O/I on both the cranium and mandible. First, a new layer was created 

(Tool>Layers>New Layer) (�g 32-A1) and assigned a name, making sure that Record is activated (�g 32-

A2). Second, the area targeted for patterning was masked and then inverted (�g 33-A, B). �ird, the alpha 

was imported (Brush Alpha>Import), loaded into the Standard Brush with the Drag Rect stroke, then 

Figure 30. Dimensions of magnet (top left) and tolerance model (lower left). Orthographic view of 
magnet (dotted white line) within tolerance model. Reference line (arrow) used for alignment during 

Boolean subtraction. Not all text intended to be read.

Figure 31. Isometric perspective drawing of embossed pattern for origin (left) and 
debossed pattern for insertion (right).
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Figure 32. Layers palette showing deep temporalis layer set to record 
(A2), new layer button (A1), and Bake All button (A3). Deformation 

palette with O�set set to -0.75 (B). Alpha pallette (C) indicating 
pattern (C1), inverse button (C2) and tiling adjustment sliders (C3).  

A.

Figure 33. Creating origin and insertion patterns on right cranium. Masked area for Deep temporalis origin 
(A). Inverted mask (B). Surface targeted for patterning is raised with using Deformation>O�set tool (C). Origin 

pattern on surface after using Standard brush with Drag-Rect stroke with alpha pattern (D).
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modi�ed by increasing the H and V Tiling to a value of 10 (Alpha>Modify>H Tiling, V Tiling) (�g-32, 

C3).  To create a more distinct boundary for the origin or insertion area, a slight o�set was created using the 

deformation tool (Tools>Deformation>O°set>select axis) and the Move brush (�g 32-B; �g 33-C). �e 

model was positioned in a view normal to surface and the pattern was dragged to a desired size (�g 33 D). 

Depending on the complexity of the surface, the pattern may distort based on the view. Several attempts may 

be necessary to achieve the desired appearance, adjusting the view as necessary. Once satisfactory, Record is 

turned o� and the Intensity of the appearance was adjusted (this is much like adjusting the opacity setting of 

a layer in Photoshop).

For areas of the model with complex surfaces, such as the insertion site of the medial pterygoid, using 

the Standard Brush with a Drag Rect stroke to apply the pattern produced undesirable results. Instead, the 

Track brush was used in conjunction with the Alpha pattern. �is brush does not appear within the default 

brush menu and must be loaded from Lightbox ( “,”>Brush>Tracks Folder). �e pattern is created by 

clicking and dragging on the surface in the same way one uses a sculpting brush to a�ect topology. It should 

be noted, however, that H and V-Tiling must be set to a value of “1” for this brush function. While the 

Track brush was more e�ective for certain areas than the earlier approach, a small amount of distortion still 

occurred and some manual clean-up was necessary. Using layers within ZBrush prevents general sculpting 

of the subtool. �is is resolved by creating additional layers or the patterned layers can be “baked” into the 

model (Tools>Layers>Bake All) (�g 32-A3). To preserve editing of the layers, a separate �le was saved before 

baking. Once baked, general sculpting can resume. �e Damien Standard brush was used to tighten edges 

around the perimeter of each site of origin and insertion.

IX: Digital Renderings

 Using the GoZ functionality within ZBrush, a version of the digitally reconstructed skull and 

musculature without assembly features was exported to Cinema 4D for the purpose of creating photorealistic 

renderings. Before exporting, however, several steps were taken to create texture maps which would embed 

color information onto the polys of each muscle subtool. �e cloned PSD �le of the texture map was edited 

in Adobe Photoshop to add detail to the muscle �bers and connective tissue. Color di�erentiation between 

dentition and bone was also desired but, unfortunately, the geometry of the bony anatomy was not compatible 

with the UV Map functionality. Masking was used to separate the dentition and cranium/mandible into 

polygroups (Tools>Polygroups>From Masking), and then their own repsective subtools. �ey could then be 

rendered di�erent materials within Cinema 4D.
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Figure 34. Screen captures of the UV 
Master and Texture Map palettes 
within ZBrush. Numbered arrows 
indicate order of steps outlined in 
text as well highlight the counter-
intuitive design of the interface.
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Figure 35. Cloned Deep temporalis subtool with 
control painting applied (A). Display of seam after 

performing an Unwrap (B). Subtool with  
polypaint applied (C).
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Step 1: UV Maps 

 Under Tools>UV Map, the UV Map Size was set to 2048. Next, using the UV Map palette 

(Zplugin>UV Master), Work On Clone was selected, the isolated subtool was unwrapped (UV 

Master>Unwrap) and the seams were checked for proper placement (UV Master>CheckSeams) (�g 34). 

If the seam traversed an area of the mesh in an undesirable way, Enable Control Painting was used to try 

and redirect its path. Selecting Protect (UV Master>Protect) and then painting on the model (default color 

is red) instructs the software to avoid placing the seam in that location (�g 35-A, B). Using Attract (default 

color is blue) instructs the software to do the opposite and attempts to place the seam in the painted location. 

For subtools with more complex geometry, several attempts were necessary to create seams that followed a 

desirable path, such as on a non-visible face or along an edge that would serve as a useful landmark during 

re�nement of the texture map in Photoshop. Once a seam was deemed satisfactory, the UV map was copied 

(UV Master>Copy UVs) and then pasted (UV Map>Paste UVs) onto the corresponding subtool in the 

original �le.

Step 2: Polypainting and Texture Map creation

 After UV’s were mapped onto the surface, each muscle subtool was polypainted (�g 35-C). With 

polypainting active (Tools>Polypaint>Colorize) the subtool was �lled with a base color (select color then 

goto Color>Fill Object). Next, using the Standard Brush with Zadd and Zsub deselected and Rgb turned 

on, areas of connective tissue were generalized using a light grey color and creases between muscle �bers were 

painted in dark red (texture maps appear �at within Photoshop and denoting location of the creases improved 

the work�ow when adding further detail). Lastly, the texture map was created from the polypaint information 

(Tools>Texture Map>New From Polypaint), cloned to the texture selection box on the left side of the screen 

(Texture Map>Clone Txtr), then exported and saved as a PSD �le.

Step 3: GoZ Export to Cinema 4D

 Unlike most interactions within ZBrush, the transfer of mesh data to Cinema 4D is remarkably 

easy and intuitive. First, the application preference for the GoZ exporter was set to Cinema 4D 

(Preferences>GoZ>Path to Cinema 4D). Next, each subtool was isolated and exported (Tools>GoZ) into a 

single Cinema 4D �le.

Step 4: Scene Rigging in Cinema 4D

 When using the GoZ export function, ZBrush automatically creates a material with an embedded 

texture map for each subtool. Before adding additional detail to each muscle, the PSD texture maps, lighting 
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and cameras were rigged, then scenes were composed for each view using the Take functionality within 

Cinema 4D. Establishing the scene beforehand streamlined the work�ow of adding textural detail to muscles 

as well as any other changes to the model.

Lighting

A main area light was positioned to the upper left of the model, the color was changed to a 

subtle warm hue, the intensity set at 100%, soft shadows were turned on and the fallo� set to Inverse 

Square-Physically Accurate (goto light Object Manager>Details>Fallo°>Inverse Square (Physically 

Accurate)). A second area light was placed to the lower right, the color was changed to a subtle cool hue, 

the intensity set to 50, soft shadows were turned o� and the fallo� also set to Inverse Square-Physically 

Accurate. An omni light set an 50% intensity with Ambient Illumination turned on (goto light Object 

Manager>General>check Ambient Illumination) was added to the scene, brightening the overall 

appearance of the model. �is technique achieves the same result of using global illumination, however, does 

not impact render times. Lastly, a third area light was added having a neutral hue, a 50% intensity, shadows 

turned o� and an Inverse Square fallo� to locally �ll areas of the model that were in shadow such as the 

pterygoids when viewed from a medial or ventral position (�g 36).

Materials

All muscle materials took advantage of the Color, Luminance, Re�ectance and Bump channels. 

�e GoZ export automatically generated a material with an embedded texture map for each muscle (�g 37). 

Within the Color Channel, the Texture was set to Layers. Clicking on the adjacent image icon brings up 

another menu where the cloned copy of the texture map can be loaded by clicking on the Image button. �e 

blending mode for each layer was left at Normal.  Next, the Luminance channel was set with Brightness 

at 5% and the same cloned texture was loaded into the Texture tab. Next, the Mix Mode was changed to 

Add and Mix Strength set to 10%. Within the Re�ectance channel, the Type was changed to Beckmann, 

Attenuation to Additive, Roughness set at 6%, Re�ection Strength at 1% and Specular Strength at 5%. 

Figure 36. Screenshots of lighting rig within Cinema 4D: main area light (A), primary �ll light (B), secondary �ll light 
(C) and ambient light (D).
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Lastly, the appearance of subtle irregularity in the muscle surface was achieved by adding a Bump channel. 

�e Texture was set to Noise and the Hama noise pattern selected with the following settings: Global Scale - 

5%, Low Clip - 20%, Contrast -80%.

Takes

Cinema 4D’s take system automates the rendering process by setting up multiple scenes within 

the same �le. Takes were created for lateral, medial, dorsal and ventral views (Take Manager>File>New 

Take) and several child takes were created within each view that progressively turned o� layers of muscle 

groups (right click on take>New Child Take). All takes below the top level take will inherit the properties 

of its parent unless overridden. To customize the view within a take, Lock Overrides must be activated 

(Take Manager>Override>Lock Overrides). Next, the new take is selected and Auto Take is turned on. 

Parameters governing the scene such as individual model position, visibility, camera selection and lighting 

attributes were set for each take. Once satisfactory, Auto Take was turned o�. Renderings of each take were 

automatically generated by selecting Rendering all Takes to PV (�g 38).

Figure 38. Screenshot of take manager window indicating New Take (A), Auto 
Take (B), Lock Override (C) and Render All Takes to PV buttons (D). Not all 

text intended to be read.

Figure 37. View of shaders within Material Manager of the Cinema 4D project �le.



Figure 39. Texture map before (left) and after (right) addition of detail.
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Step 5: Texturing in Photoshop

Adding detail to the cloned texture map of the musculature was performed in Adobe Photoshop via 

pathways embedded within the Material Editor of Cinema 4D. Within the Color channel, the Texture was 

set to Layer. Next, clicking on Layer opens a dialog window and by clicking the Image button, the cloned 

texture (saved as separate �les out of ZBrush earlier in the work�ow) was added. �e added textures are easlity 

edited by clicking the image icon for that layer and selecting Edit Image. Cinema 4d will automatically open 

the �le within Photoshop. When the addition of detail within Photoshop was complete, the �le was saved and 

the texture was then updated in Cinema 4D by clicking Reload Image. 
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Using both the DICOM dataset of hard tissue structures and volumetric information acquired from 

dissection, a digital reconstruction of the masticatory apparatus of the phalangeroid possum, Trichosurus 

vulpecula, was created in ZBrush. Both 3D printed model and �at illustrations were created from the digital 

reconstruction with the goal of improving communication of spatial relationships and other details of 

phalangeroid chewing musculature.

I: Design Criteria

After the summary of responses was analyzed, the following design criteria for the model were derived.

1. �e model must be accurate with respect to anatomy, overall dimensions, and appearance.

2. �e model must clearly demonstrate the position and layers of each muscle group.

3. �e model must clearly demonstrate the origin and insertion of the layers of each 

 muscle group.

4. �e model must demonstrate the �ber direction of each muscle.

5. �e model must give an accurate representation of the relative mass and volume of each 

muscle with respect to each other.

II: Flat Illustration

Flat illustrations of the bony anatomy clearly describe anatomical landmarks important to 

understadning origin and insertion of the muscular anatomy. �ree dimensional photo realistic still renderings 

of the digital model demonstrate muscle layers in �at space as well as associated structures important when 

conducting dissections. As with the physical model, the illustrations rely upon real data and provide a highly 

accurate representation of muscle volume, shape, �ber direction and sites of origin and insertion.
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Figure 40. Anatomical landmarks of the cranium, (Trichosurus vulpecula).
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Figure 41. Anatomical landmarks of the mandible (Trichosurus vulpecula).
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Figure 42. Origin and insertion of the Masseter group (Trichosurus vulpecula).
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Figure 43. Origin and insertion of the Temporalis group and Pterygoids (Trichosurus vulpecula).
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III: Digital Reconstruction

A: Physical Model

Two versions of the digital reconstruction were created. One model was designed for 3D printing and 

contained local thickenings of tendinous attachments as well as mechanical features to allow the user to add 

and remove muscle layers. �e physical model provides the audience with a multi-sensory tactile experience 

from which they can learn about the spatial relationships and other aspects of the phalangeroid masticatory 

apparatus. �e model can be used as a stand-alone didactic tool or in conjunction with 2D assets to learn 

about phalangeroid anatomy. Additionally, both can be used to draw conclusions about the relationship 

between phalangeroids and Lemuriformes.

Figure 44. Photograph of the �nal physical model in assembled form.

© Nicholas Reback 2017
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Figure 45. Photographs of the �nal model, caudal (top) and disassembled (bottom).
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Figure 46. Photography of the �rst (top) and second (bottom) prototype.
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B: Virtual Model 

�e second version of the digital reconstruction was produced without localized thickenings or 

assembly features in order to accurately represent muscle anatomy in photo realistic renderings. Additionally, 

this version could be used to create assets such as animations and static two dimensional images for use in 

interactive media designed for educational or research purposes. 

IV: Anatomy of Musculature

�e Masseter group is most super�cial of the jaw adductors and contains four layers representing an 

38.2 % of the total mass and weighs 2.5 grams (g). From super�cial to deep the layers are super�cial masseter, 

external part of the external adductor (EPEA), internal part of the external adductor (IPEA), and zygomatico-

mandibularis. Super�cial masseter is the largest of these and represents 21.2 % of total mass and weighs 

1.36 g. Its origin occurs on a relatively small patch on the anterior zygomatic tubercle and inserts broadly on 

the posterior surface of the angular process and ramus of the mandible. From caudal to rostral the �bers are 

oriented in a slightly oblique fashion dorsally, indicating its role as a power adductor as well as a protractor 

of the mandible. �e EPEA and IPEA are thin sheet like muscles that are tightly invested with each other. 

�eir origins occur on the inferior edge of the zygomatic arch, caudal to the anterior tubercle and insert on 

the antero-lateral edge of the ramus. �e �bers are oriented vertically from ventral to dorsal, indicating a role 

in adduction. Together they represent 12.8% of the total mass and weigh 0.824 g. Zygomatico-mandibularis, 

another relatively sheet-like muscle and the last layer of the masseter group, weighs only  

0.27 g and represents 4.2 % of the total mass. Its origin is medial and adjacent to that of IPEA, however, it 

has a broad insertion on the lower lateral surface of the coronoid. �e �bers of zygomatico-mandibularis are 

oriented in parallel with EPEA and IPEA.

�e Temporalis group is the largest of the jaw adductors consisting of 43.2% of total mass, weighing 

2.78 g, and consists of three layers: super�cial temporalis, deep temporalis and zygomatic temporalis. All 

three muscles function as powerful elevators of the mandible. Collectively and individually, the shape of 

the temporalis group is more complex than either the Masseter group or Pterygoids. Super�cial temporalis 

represents 10.6% of the total mass and weighs 0.68 g. �e �bers run rostral to caudal in a largely horizontal 

plane before turning ventrally to insert on the rostral edge of the coronoid. Deep temporalis consists of 20% 

of the total mass, and is the second largest adductor after super�cial masseter weighing 1.30 g. It has a broad 

area of both origin and insertion on the dorsum of the cranium and medial face of the coronoid, respectively.  

Zygomatic temporalis represents 12.4% of the total mass and weighs 0.80 g. It has a broad origin on the 

medial surface of the zygoma and insertion on the upper-lateral surface of the coronoid. 
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�e pterygoids are the smallest muscle group representing 18.6% of the total mass and have a 

combined weight of 1.20 g.  �e medial pterygoid is the larger of the two muscles at 13.3 percent total mass 

and weighing 0.86 g. It originates on the lateral surface of the pterygoid plate and inserts broadly on the 

medial surface of the mandible within the pterygoid fossa. Its �bers run oblique in both dorsal-ventral as well 

as lateral to medial planes. �e lateral pterygoid has a narrow band of origin superior to the edge of the lateral 

pterygoid plate and a small insertion just above its medial counterpart and below the temporomandibular 

condyle. Its �bers run obliquely from medial to lateral while the muscle itself lies on a horizontal plane. Lateral 

pterygoid is the second smallest muscle of the jaw adductors at only 5.3 % total mass and weighing 0.34 g. 

Both lateral and medial pterygoid function to protrude the jaw and likely have a role horizontal translation.
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Figure 47. Musculature, super�cial layers.
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Figure 48. Deep layers of the Masseter group.
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Figure 49. Deep layers of the Temporalis group.
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Figure 50. Position of the Pterygoids.
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V: Work�ow Documentation

Documentation of the work�ow is presented as two parallel paths: physical and digital (�g 51). In 

the beggining these paths are not mutually exclusive. For example, muscle reconstruction cannot start before 

completing dissections. Timing was such that the latter step did not begin until Januray 18th, leaving a scant 

62 days to complete the project. Likewise, neither version of the digital model could be �nalized until volume 

veri�cation was complete. 

�e paths converge halfway through during the iterative phase of prototyping and volume 

veri�cation, after which the two halves separate, allowing some measure of multi-taksing while the �nal 

prototype is being produced. Omitted from the work�ow are the many dead ends and failed attempts 

encountered while experimenting with various techniques to achieve the project goals. 
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Figure 51. Work�ow diagram separated into digital and physical tasks.
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VI: Asset Referral

Access to the 2D assets created for this thesis is available at www.rebackbiomedicalmedia.com 

or by contacting the author at nicholasreback@gmail.com. �e author may also be contacted through 

the Department of Art as Applied to Medicine at Johns Hopkins University School of Medicine or via the 

department website www.hopkinsmedicine.org/medart.
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It can be said without much disagreement that the success of a medical illustrator is limited by their 

breadth of scienti�c knowledge and depth of artistic ability. �e primary personal goal of this thesis was to 

not only increase the depth of my technical ability with a wide range of artistic tools, but also expand my 

knowledge of scienti�c subject matter. �e secondary goal, driven by more than a decade of professional 

experience, was to select a preceptor with whom I could have a positive working relationship, a factor I deem as 

a core constituent of the most successful projects of my past. 

II: Production Goals and Challenges

Production goals within the scope of the project included the use of a variety of tools and techniques 

to compose a clear and intuitive narrative about Strepsirrhine-phalangeroid convergence as well as the 

masticatory apparatus of the latter. It is my hoep that resources presented here will improve the ability of the 

audience to understand possum morphology, ecology and biology as well as draw meaningful comparisons to 

lemuriformes and, eventually, conclusions about primate origins. Documentation of the work�ow will allow 

third parties to successfully replicate these results with respect to other taxa. �e 3D applications employed are 

powerful asset creation tools in their own right. In combination, however, the number of possible pathways to 

success is overwhelming and navigating this required a signi�cant amount of trial and error .

�e most challenging aspect of this project involved familiarization with primate and metatherian 

evolutionary biology, an area of scienti�c study with which I had no prior knowledge. In the months prior 

to the �rst dissection, many hours were spent conducting a broad literature in order to �rmly grasp concepts 

in evolutionary biology, relevant terminology, possum ecology, hypotheses of primate origins and general 

primatology. As is often the case, the project was made more challenging by uncontrollable factors such as 

schedule delays, procedural dead ends and cost constraints with respect to manufacturing the physical model. 

�at being said, organization and time management were powerful assets in remaining �exible in the face of 

adversity while maintaining forward momentum. For example, the digital reconstruction could not proceed 

before dissections were completed and so literature reviews, software training, preliminary 2D asset creation 

and preparation for qualitative user interviews proved to be an e�ective time saving strategy.
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II: Digital Work�ow

A: Z Brush

Working in ZBrush consumed the greatest proportion of the time during the project. While this 

was anticipated, the most ine�cient periods were largely due struggles with the unintuitive nature of the 

user interface. �e design does not mirror the UI of more ubiquitous asset creation applications such as 

Adobe’s Creative Suite or standard packages from Microsoft, and its layout makes it di�cult for one to form 

a mental picture of the location of many commonly employed tools. �e task of learning ZBrush involved 

many hours wathcing tutorials, taking notes and practicing new techniques within and outside of the project. 

Ironically, the most useful resource with respect to skill development came from instructional videos found 

on the manufacturers website: www.pixologic.com/zclassroom/. �ese are well structured, chunked out into 

reasonable lengths of time and can be bookmarked for later viewing by creating Pixologic pro�le.

�e functionality of ZBrush is targeted toward artists and the program itself o�ers little in the way 

of parametric controls like those found in engineering packages such as SolidWorks or even that of animation 

software like Cinema 4D. �ere were many moments of doubt as to whether the model was at the right scale. 

�e model needed to be exported to Cinema 4D, SolidWorks, and in one case Avizo to ensure the scale was in 

fact correct. Sizing of assembly features like press-�ttings and pockets for magnets was also problematic and 

prone to error.

B: Cinema 4D

Cinema 4D is a robust 3D modeling and animation program within many embedded tools that 

make the production of still images fast and forgiving. While the UI is not as unintuitive as ZBrush, there 

were still challenges inherent to identifying the best tools for the task at hand. For example, there is not 

commonality between either software package with respect to hot key function and assignment. In a similar 

fashion to learning ZBrush, web-based tutorials, particularly those on greyscalegorilla.com, were especially 

useful. Unfortunately, many of these are quite long  may contain a lot of irrelevant content. 

III: Physical Work�ow

A: Dissection

Dissection was assisted by Dr. Jonathan Perry at the Center for Functional Anatomy and Evolution at 

Johns Hopkins University School of Medicine. A total of four Trichosurus vulpecula specimens were dissected, 

however, dental analysis of two specimens revealed they were juvenile and would adversely a�ect the data on 
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muscle mass. �e data used for reconstruction was therefore based on only two adult specimens, a male and 

female of almost identical size. Dissection of the muscles was performed with caution and individual layers 

were removed in whole without mutilation, however a larger sample size from 3-5 specimens would have  

been preferred. 

B: 3D Printing

With any project involving a digital to physical asset transition, cost must be taken into 

consideration. �e cost associated with 3D printing is based on platform type and material use. �e platform 

used for the project was comparatively expensive due to its resolution and ability to print multiple colors and 

materials within a single run. Signi�cant savings were achieved by reducing scale, printing in single material 

mode when possible and employing packing strategies to decrease material use, particularly for the support. 

For example, only the lateral half of the cranium and mandible was printed for the �rst prototype at 150% 

actual size. �e second prototype needed to be full scale to allow test �tting of magnetic fasteners as well as 

user interaction. �e scale was increased to 200% and both halves of the cranium and mandible were printed, 

but only a single material was used and STL �les were strategically assembled to signi�cantly reduce the 

consumption of support material (i.e.: the pterygoids were relocated to a position within the braincase of either 

half). If both prototypes were printed in full color and at the same scale as the �nal model it would have added 

over $500 to the cost of project.

A 3D printer is often a shared resource, and this project was no exception in this regard. Depending 

on the type and number of jobs in the queue, a print may experience delays from several hours to days. 

Additionally, the process of 3D printing is not analogous to production of documents. A job requiring a 

change in material durometer or color requires that the printer undergo an optimization, a procedure that took 

approximately 2-3 hours. Understanding the printing process and opening a direct line of communication 

with sta� managing the 3D printer, in this case, Juan Garcia and Sarah Chen, is important in setting realistic 

expectations and reducing frustration.

C: Response to the Physical Model

Due to time constraints the model was not formally tested for the submission of the thesis. Overall 

response, however, was positive and users expressed enthusiasm at the ability add or remove muscle layers and 

felt the model helped them to better understand spatial relationships. When asked to assemble the model from 

scratch, users struggled to understand the order of assembly. Knowing the assembly order beforehand is not a 

learning objective of the model and so a set of instructions will likely be designed to help direct �rst-time users 

through this process.
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Much e�ort was expended to ensure accuracy of the model with respect to muscle mass and 

volume as well as contextual details such as �ber direction, connective tissue, suture lines and dentition. 

Unfortunately, two of the representative muscles, zygomatico-mandibularis and zygotamics temporalis, could 

not be made small enough to re�ect measurements taken from dissection specimens. It is possible that due to 

the length of time the muscles were preserved, some decomposition of surrounding tissue took place.
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Respondent 1 Respondent 2 Repondent 3 Respondent 4 Respondent 5
PART I 1/13/17 2/2/17 2/6/17 2/8/17 2/13/17
Current Degree Status PhD/Professor MS PhD/Assistant Professor BS-Anthropology PhD/Assistant Professor

Current field of study
Paleontology - early mammals of 

South America/Carribean

Primatology- changes in masticatory 
aparratus of Lemurs through 

maturation cycle

Studies dentition and cranial 
morphology in strepshirrine primates

Evolution of food in strepshirrine 
primates

Primate locomotion and its effect on 
the skeletal system

Is the study of mammalian chewing muscles 
important to you work?

Y Y Y Y Indirectly

If "yes," can you explain why?

Understanding a species niche 
(environment animal lives in, diet, 
competitors); what they eat/how 
food is processed informs us where 
they fall in fauna diversity; cranial 
mandibular chapes; pathology: TMJ 
possibly caused by missing dentition

How do animals gain ability to feed 
independently on solid food; 
transition from milk to solids; helps 
with behavioral studies, husbandry; 
compare to juvenille fossil material

chewing muscle function, esp force 
generation, affects morphology

muscles contract-cause action; size of 
muscle affects force generation; 
muscle reconstruction allows 
understaning of chewing

If "no," can you explain why it is an important 
subjet to study?

postcranial purpose is to move 
digestive/reproductive systems within 
environment, adapted to gathering 
food; chewing muscles essential for 
locomotion, defense and 
reproduction

 What types of information about chewing muscles 
are you interested in?

Fiber direction; overall mass, O/I, 
potential force generation

Fiber direction/length, O/I, PCSA, 
force production, 
apperance/pennation; change/time

differences b/w species, relationship 
to what they eat; size and position of 
muscles as well as attachments (O/I)

action/direction, force production, 
active vs nonactive muscle during 
cycle; area of O/I 

biomechanical perspective, PCSA, 
O/I, pennation angle; 
activation/EMG data, when muscles 
are active during cycle

How do you use this information?

most work is with bones; look at 
attachments, how muscles "might 
have" functioned in paleontological 
record; compare extinct to extant 
species

changes in O/I suggest change in 
function/action; how chewing 
changes over time

O/I and landmarks used for 
morhpological measurements; force 
production; measurement of condyle 
to diff dental positions

in early phase of research; looking at 
big picture.

N/A

In what ways is this data typically represented?

line drawings, CT and/or MRI 
datasets/images, photography

text is most common; drawings of 
jaw/skull; vector drawing of 
attachments; 3D pdf export from 
Aviso

O/I is outlined; verbal desciption 
(text), 3D model with line of actions 
represented like bands

text, math, schematics, diagram of 
insertions; lucky to get a nice 
illustration

PCSA: numbers/tables; pennation: 
angle values; O/I color coded 
orthographic views

Can you compare the relative effectiveness of these 
representations as learning/communication tools?

not effective for communicating 
complicated movements of chewing 
exp medial/lateral

text cannot be poorly worded in a 
paper, but images are not held to 
same standard; often not 
good/relevant to area of interest; 
photos lit poorly; need to appreciate 
things spatially; helpful to have 
layers, multiple points of view

2D tools hard to relate different 
views/levels of dissection

no answer effective for what they are trying to 
communicate

Are there any aspects of studying MCM that 
particularly difficult to understand?

pterygoids: hidden by mandible, very 
three dimensional, complicated 
structure and function; medial lateral 
movement

dissection: clean removal of muscle 
from attachment site is challenging; 
hard to see inside of zygoma; 
insertions

triangle of support model; muscle 
layers and their actions; fiber 
direction; pterygoids - not easy to see

many ways to chew, how will boney 
structure affect chewing

pterygoids- hidden behind mandible, 
must be imagined, 

PART 2

If you could design your own tool for 
teaching/communicated MCM, what would it look 
like?

3D virtual skull stripped of all but 
chewing muscles with ablitiy to 
simulate chewing motion; 

prefers learning from a physcial 
model; something I could rotate; 
fade in/out muscles; animation of 
chewing

way to visualize tooth 
complex/pattern of occlusion as it 
relates to distribution of force; would 
show how much line of action is 
moving relative to fulcrum

a virtual model that would allow 
gathering of physcial properties of 
food; reconstruction of chewing 
muscles;

detailed virtual model of 
crania/mandible with chewing 
muscles attached;

What features do you think would improve the 
effectiveness of the following as a teaching tool:

A) 3D virtual model

anmiations showing chewing; 
muscles light up depending on 
activation; motion of a single muscle

see above show chewing cycle, position (of 
muscles) at various points in gape; 
see muscles in isolation and 
combined; alter parameters (ie: 
PCSA) and see effects 

see above  rotate model; turn on/off chewing 
muscles; visibility of attachment sites; 
active muscles light up; see muscles 
deform

B) 3D Physical model
accuracy is important; extraneous 
infomration not releveant to area of 
study should be removed

mulitple models with different 
groups of muscles on them; show 
fiber direction; pennation

part of mandible transparent to see 
how dentition occludes; take on/off 
muscles; ability to articulate

ability to test fracture point of food; 
tooth material similar to real teeth; 
articulated jaw within limits

saw physical model made with air 
bladders that deformed while 
produced motion

Have you ever used a 3D virtual or physical model 
as a teaching/communication tool in the past?

Y Y Y Y Y

If "yes," can you give examples?

laser scanning of dentition, note 
landmarks, compare sets of data,  3D 
prints (bones/skulls) used to teach 
students

Real specimens; Google anatomy; 
Anatomia model of eye movements

physcial specimens; models used to 
teach undergraduates (ie: pelvic 
floor); have not used a lot of virtual 
models

Avizo, CT scans, real specimens, 
casts

Made plywood model to study 
patella movement; virtual models 
useful for teaching anatomy

Desciribe how the model was useful to you?

learning from a 3D model is 
multisensory; see and touch, 
paletontology is tactile; easier to 
make comparison with physcial 
specimen

physcial models/real specimens help 
concepts click; 

physical model can be shared among 
greater number of students; physical 
model is more "active"; 

CT has ability to zoom in on detail; 
set landmarks and measure distance; 
doesn't damage like a real specimen

little substitute for ability to 
see/touch; value of dissection; 
desctription would not be efficient; 

Where there anyways the model was not effective as 
a teaching or communication tool?

muddy/poorly executed photography 
and/or diagrams; only useful to 
experienced audience, not to 
students; area of interest is covered 
by structures not relevant to study

not many models out there. Current 
2D visuals are usually poor quality

physcial model cannot be shared 
across distance but virtual model can; 
physcial model may not represent 
variation (become standardized); 
changes over time not shown; models 
need to simplify but sometimes go to 
far

takes certain amount of practive to 
use virtual tools

has to be some simplification in any 
representation; inherently some 
amount of misleading info; 
researchers oversimplify to explain 
ideas

Appendix
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Respondent 1 Respondent 2 Repondent 3 Respondent 4 Respondent 5
PART I 1/13/17 2/2/17 2/6/17 2/8/17 2/13/17
Current Degree Status PhD/Professor MS PhD/Assistant Professor BS-Anthropology PhD/Assistant Professor

Current field of study
Paleontology - early mammals of 

South America/Carribean

Primatology- changes in masticatory 
aparratus of Lemurs through 

maturation cycle

Studies dentition and cranial 
morphology in strepshirrine primates

Evolution of food in strepshirrine 
primates

Primate locomotion and its effect on 
the skeletal system

Is the study of mammalian chewing muscles 
important to you work?

Y Y Y Y Indirectly

If "yes," can you explain why?

Understanding a species niche 
(environment animal lives in, diet, 
competitors); what they eat/how 
food is processed informs us where 
they fall in fauna diversity; cranial 
mandibular chapes; pathology: TMJ 
possibly caused by missing dentition

How do animals gain ability to feed 
independently on solid food; 
transition from milk to solids; helps 
with behavioral studies, husbandry; 
compare to juvenille fossil material

chewing muscle function, esp force 
generation, affects morphology

muscles contract-cause action; size of 
muscle affects force generation; 
muscle reconstruction allows 
understaning of chewing

If "no," can you explain why it is an important 
subjet to study?

postcranial purpose is to move 
digestive/reproductive systems within 
environment, adapted to gathering 
food; chewing muscles essential for 
locomotion, defense and 
reproduction

 What types of information about chewing muscles 
are you interested in?

Fiber direction; overall mass, O/I, 
potential force generation

Fiber direction/length, O/I, PCSA, 
force production, 
apperance/pennation; change/time

differences b/w species, relationship 
to what they eat; size and position of 
muscles as well as attachments (O/I)

action/direction, force production, 
active vs nonactive muscle during 
cycle; area of O/I 

biomechanical perspective, PCSA, 
O/I, pennation angle; 
activation/EMG data, when muscles 
are active during cycle

How do you use this information?

most work is with bones; look at 
attachments, how muscles "might 
have" functioned in paleontological 
record; compare extinct to extant 
species

changes in O/I suggest change in 
function/action; how chewing 
changes over time

O/I and landmarks used for 
morhpological measurements; force 
production; measurement of condyle 
to diff dental positions

in early phase of research; looking at 
big picture.

N/A

In what ways is this data typically represented?

line drawings, CT and/or MRI 
datasets/images, photography

text is most common; drawings of 
jaw/skull; vector drawing of 
attachments; 3D pdf export from 
Aviso

O/I is outlined; verbal desciption 
(text), 3D model with line of actions 
represented like bands

text, math, schematics, diagram of 
insertions; lucky to get a nice 
illustration

PCSA: numbers/tables; pennation: 
angle values; O/I color coded 
orthographic views

Can you compare the relative effectiveness of these 
representations as learning/communication tools?

not effective for communicating 
complicated movements of chewing 
exp medial/lateral

text cannot be poorly worded in a 
paper, but images are not held to 
same standard; often not 
good/relevant to area of interest; 
photos lit poorly; need to appreciate 
things spatially; helpful to have 
layers, multiple points of view

2D tools hard to relate different 
views/levels of dissection

no answer effective for what they are trying to 
communicate

Are there any aspects of studying MCM that 
particularly difficult to understand?

pterygoids: hidden by mandible, very 
three dimensional, complicated 
structure and function; medial lateral 
movement

dissection: clean removal of muscle 
from attachment site is challenging; 
hard to see inside of zygoma; 
insertions

triangle of support model; muscle 
layers and their actions; fiber 
direction; pterygoids - not easy to see

many ways to chew, how will boney 
structure affect chewing

pterygoids- hidden behind mandible, 
must be imagined, 

PART 2

If you could design your own tool for 
teaching/communicated MCM, what would it look 
like?

3D virtual skull stripped of all but 
chewing muscles with ablitiy to 
simulate chewing motion; 

prefers learning from a physcial 
model; something I could rotate; 
fade in/out muscles; animation of 
chewing

way to visualize tooth 
complex/pattern of occlusion as it 
relates to distribution of force; would 
show how much line of action is 
moving relative to fulcrum

a virtual model that would allow 
gathering of physcial properties of 
food; reconstruction of chewing 
muscles;

detailed virtual model of 
crania/mandible with chewing 
muscles attached;

What features do you think would improve the 
effectiveness of the following as a teaching tool:

A) 3D virtual model

anmiations showing chewing; 
muscles light up depending on 
activation; motion of a single muscle

see above show chewing cycle, position (of 
muscles) at various points in gape; 
see muscles in isolation and 
combined; alter parameters (ie: 
PCSA) and see effects 

see above  rotate model; turn on/off chewing 
muscles; visibility of attachment sites; 
active muscles light up; see muscles 
deform

B) 3D Physical model
accuracy is important; extraneous 
infomration not releveant to area of 
study should be removed

mulitple models with different 
groups of muscles on them; show 
fiber direction; pennation

part of mandible transparent to see 
how dentition occludes; take on/off 
muscles; ability to articulate

ability to test fracture point of food; 
tooth material similar to real teeth; 
articulated jaw within limits

saw physical model made with air 
bladders that deformed while 
produced motion

Have you ever used a 3D virtual or physical model 
as a teaching/communication tool in the past?

Y Y Y Y Y

If "yes," can you give examples?

laser scanning of dentition, note 
landmarks, compare sets of data,  3D 
prints (bones/skulls) used to teach 
students

Real specimens; Google anatomy; 
Anatomia model of eye movements

physcial specimens; models used to 
teach undergraduates (ie: pelvic 
floor); have not used a lot of virtual 
models

Avizo, CT scans, real specimens, 
casts

Made plywood model to study 
patella movement; virtual models 
useful for teaching anatomy

Desciribe how the model was useful to you?

learning from a 3D model is 
multisensory; see and touch, 
paletontology is tactile; easier to 
make comparison with physcial 
specimen

physcial models/real specimens help 
concepts click; 

physical model can be shared among 
greater number of students; physical 
model is more "active"; 

CT has ability to zoom in on detail; 
set landmarks and measure distance; 
doesn't damage like a real specimen

little substitute for ability to 
see/touch; value of dissection; 
desctription would not be efficient; 

Where there anyways the model was not effective as 
a teaching or communication tool?

muddy/poorly executed photography 
and/or diagrams; only useful to 
experienced audience, not to 
students; area of interest is covered 
by structures not relevant to study

not many models out there. Current 
2D visuals are usually poor quality

physcial model cannot be shared 
across distance but virtual model can; 
physcial model may not represent 
variation (become standardized); 
changes over time not shown; models 
need to simplify but sometimes go to 
far

takes certain amount of practive to 
use virtual tools

has to be some simplification in any 
representation; inherently some 
amount of misleading info; 
researchers oversimplify to explain 
ideas
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MUSCLE VOLUME WORKSHEET

TEXTURE

IMAGE REF MUSCLE NAME #236802 (g) #237806 (g) AVG (g) % INITIAL r1, r2 t1, t2

Superficial Masseter 1.359 1.369 1.364 21.2% 1.56 1.44, 1,36 1.43, 1.35

EPEA 0.453 0.685 0.569 8.8% 0.38 0.63, .56 .63,.56

IPEA 0.226 0.284 0.255 4.0% 0.36 .35,.26 0.3

Zygomatico-
mandibularis

0.267 0.27 0.2685 4.2% 0.71 .56,  .45 0.58

2.305 2.608 2.4565 38.2%

Superficial 
Temporalis

0.702 0.66 0.681 10.6% 1.41 0.79,  .69 .78, .68

Deep Temporalis 1.349 1.25 1.2995 20.2% 0.77 1.3 1.3

Zygomaticus 
Temporalis

0.767 0.832 0.7995 12.4% 1.05 1.04, .96 0.94

2.818 2.742 2.78 43.2%

Medial Pterygoid 0.835 0.879 0.857 13.3% 1 0.84 0.8

Lateral Pterygoid 0.302 0.385 0.3435 5.3% 0.38 0.35 0.34

1.137 1.264 1.2005 18.6%

TOTAL 6.26 6.614 6.437 1.000

MASSETER GROUP

TEMPORALIS GROUP

PTERYGOID GROUP

BASE SCULPTSPECIMENS

MUSCLE VOLUME WORKSHEET

TEXTURE

IMAGE REF MUSCLE NAME #236802 (g) #237806 (g) AVG (g) % INITIAL r1, r2 t1, t2

Superficial Masseter 1.359 1.369 1.364 21.2% 1.56 1.44, 1,36 1.43, 1.35

EPEA 0.453 0.685 0.569 8.8% 0.38 0.63, .56 .63,.56

IPEA 0.226 0.284 0.255 4.0% 0.36 .35,.26 0.3

Zygomatico-
mandibularis

0.267 0.27 0.2685 4.2% 0.71 .56,  .45 0.58

2.305 2.608 2.4565 38.2%

Superficial 
Temporalis

0.702 0.66 0.681 10.6% 1.41 0.79,  .69 .78, .68

Deep Temporalis 1.349 1.25 1.2995 20.2% 0.77 1.3 1.3

Zygomaticus 
Temporalis

0.767 0.832 0.7995 12.4% 1.05 1.04, .96 0.94

2.818 2.742 2.78 43.2%

Medial Pterygoid 0.835 0.879 0.857 13.3% 1 0.84 0.8

Lateral Pterygoid 0.302 0.385 0.3435 5.3% 0.38 0.35 0.34

1.137 1.264 1.2005 18.6%

TOTAL 6.26 6.614 6.437 1.000

MASSETER GROUP

TEMPORALIS GROUP

PTERYGOID GROUP

BASE SCULPTSPECIMENS
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Muscle Volume Worksheet



PRESS FIT

.335 x 
.060

.125 x 
.100

RT to LT Cranium F Good seating. Some slight gap rostrally.

RT Mandible to RT Cranium M 2 Good. Try offset spherical joint to allow more ROM.

LT Mandible to LT Cranium M 2 Good. Try offset spherical joint to allow more ROM.

LT Mandible to RT Mandible M 2 Poor. Increase depth of boss, use larger, stronger magnet.

Zygoma to LT Cranium M 4 2/subtool, (total 4 magnets)
Good. Increase tolerance gap on rostral edge of rostral 
boss.

ST to DT to Cranium M 2 Press fit sandwhich DT b/w
OK. Tighting up tolerance. Several people noted 
appearance like piggy bank.

ZT to LT Mandible M P Held fixed after addtion of Zygoma OK. Keep as is, loosen with sanding in final.

ZM to LT Mandible M P OK. Keep as is, loosen with sanding in final .

EPEA to IPEA to ZM M 2 Magnetic tab sandwhich IPEA b/w (total 2 magnets)
Good. Increase depth of boss slightly, add feature to 
keep IPEA to ZM.

SM to LT Mandible M 2 Approximate an over center snap type action
Poor. Does not stay in place try alternate connection, 
possibly magnetic as well.

MPt to LPt M 2 (total 2 magnets) OK. Increase depth of boss.

Pt's to LT Mandible M P Socket into natural shape of mandible Add feature to assemble MPt to mandible.

4 14

C
R

AN
IU

M
M

U
SC

LE
S

PHYSICAL MODEL ASSEMBLY STRATEGY AND CHECKLIST

FASTENER TOTALS:  

PROTOTYPE EVALUATIONCONNECTION
FIXED/ 

MOBILE
NOTESMAGNET (dxh (in))

FASTENER TYPE
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Prototype Assembly Strategy Checklist
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